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EDITORIAL
This magazine was created using :

By the time you read this,
will be
unleashed upon the masses. I've been
following KDE 4 since 4.0, and I can honestly
say: it's come on in leaps and bounds.
Shown left is my current desktop, KDE 4.1
RC1, with Twitter plasmoid top right, a
couple of post-it notes, middle right (yes, I
am that forgetful!), a folder view, middle top, and some shortcuts, top
left. Not only does KDE 4.1 look lovely, but it's far more usable now
than in its 4.0 incarnation. So, if you haven't given KDE 4 a try lately
(or didn't like 4.0) give it a whirl. I think you'll be impressed.
Speaking of
, you can follow us at: twitter.com/fullcirclemag,
where the team will twitter their hearts out about what they are up to
in the world of
.
I hope you enjoy this issue, and remember: we're only an email
away so feel free to let us know what you like (or dislike) and what
you want to see in future issues. Contact addresses are on the last
page of this issue.

Ubuntu is a complete operating
system that is perfect for laptops,
desktops and servers. Whether at
home, school or work Ubuntu
contains all the applications you'll
ever need including word processor,
email application and web browser.
You do not pay any
licensing fees. You can download,
use and share Ubuntu with your
friends, family, school or business
for absolutely nothing.
Once installed, your system is ready
to use with a full set of productivity,
internet, drawing and graphics
applications, and games.

Editor, Full Circle Magazine
ronnie@fullcirclemagazine.org
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NEWS
Best Buy Is Selling Ubuntu

I

t appears that
is now
selling
[just the OS, no
PC], both through its Web site
and in its brick-and-mortar
locations. Going by the release on
the product page, Ubuntu has
actually been available for the
low, low price of $19.99 since May
6th of this year. It is being
packaged as the 'Complete
Edition.' While they don't specify
on the site what version is being
offered, a quick call to a local
store revealed it to be Hardy
Heron, the latest Long Term
Support version.
: slashdot.org

Feel free to email news stories
to: news@fullcirclemagazine.org
Please include a source URL.

Apress Ubuntu Book Updated

K

eir Thomas and Jamie Sicam
have updated the best-selling
and award-winning 2006 title,

. With more
than 150 pages added since the first
edition, this new edition, based on
version 8.04, covers everything a
new user would want, and need to
know. Aimed at anyone wanting to
switch to Ubuntu, this book offers
everything a user needs to get
started, including a double-sided
DVD that contains the full version of
and much more.
According to coauthor Keir
Thomas, “Beginning Ubuntu Linux,
Third Edition purely and simply
focuses on what you need to know to
use Linux. It’s concise and to the
point, aiming to re-create under
Linux all the stuff you used to do
under Windows, or even Apple
Macintosh.”
: theopenpress.com
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Intrepid Alpha 2 Released
Intrepid Ibex Alpha 2 is the second
alpha release of Ubuntu 8.10, and with
this release comes a whole host of new
features. The feature list for 8.10 has
been slowly taking shape since early
last month. Much is yet to be decided
for 8.10

The final stable version will be released
in October 2008.
: ubuntu.com

A magazine isn't a magazine
without articles and Full Circle
is no exception. We need your
,
and
. We also need
(games, apps &
hardware),
articles
(on any K/X/Ubuntu subject)
and any questions, or
suggestions, you may have.

Shuttleworth Dream:
'out-pretty' Apple

NEWS
KDE Developers Respond To KDE
4.0 Backlash
KDE Developers
have responded to
the ongoing
controversy around
their handling of the
transition from KDE
3 to KDE 4, which
began with the
release of KDE 4.0 in
January.
With KDE 4, developers shifted the
system from the Qt 3 applicationdevelopment framework to Qt 4, while
rebuilding the desktop environment
from scratch.
The resulting software has been
criticised for its lack of features and
customisability, bugs and usability
problems. Some have suggested
including older versions of KDE
alongside KDE 4 or even creating a new
system based on KDE 3.5 but ported to
the Qt 4 framework.

"As we firmly believe in KDE 4 and
the future of the free desktop, we
expected the heated discussions about KDE
4, and especially the 4.0 release, to go
away, and we were wrong about that," he
wrote in an open letter published on the
open-source news website Groklaw.
The problems are largely due to inflated
expectations of KDE 4, something KDE
developers had attempted to address ahead
of the release, he said.
KDE 4.0 was never intended to be a full
replacement for KDE 3, but was released in
January in order to give KDE 4 application
developers a stable platform to develop to,
Kügler said.
Version 4.0 of the system was intended to
lay foundations for a system that would be
able to add functions that would have been
difficult or impossible to build onto the
ageing KDE 3 platform, Kügler said.
: ZDnet.co.uk

KDE board member Sebastian Kügler
admitted that KDE developers were
surprised by the vehemence and
persistence of KDE 4's critics.

That dream? To produce a desktop
more beautiful to ordinary users than
legions of Apple programmers supping
on the milk of chief exec Steve Jobs'
alleged brilliance are capable of
producing. That includes a desktop not
funded by a clutter of annoying banner
or Flash-based ads, but paid for by
subscription-based services.
Now you're done dreaming, go home
and code for the victory.
In a Tuesday evening O'Reilly Open
Source Convention (OSCON) keynote,
Shuttleworth called on delegates to
make a concerted effort not just to
catch Apple but to overtake the
company in the quality of the desktop
experience they deliver users.
His company Canonical, Ubuntu's
commercial sponsor, is working to
make the Ubuntu desktop "more
beautiful" in the next two years, he
told OSCON.
"I think the great task in front of us in
the next two years is to lift the
experience of the Linux desktop from
something stable and usable and not
pretty, to something that's art,"
Shuttleworth said.
: theregister.co.uk
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COMMAND AND CONQUER

Written by Robert Clipsham

L

ast month we showed you
how to stay safe using a
command line. Now that you
know this, you can start using it to
your advantage! Over the next
few issues, we'll show you the
basics of file management, which
will be of use later on when doing
more advanced things.
The first command in this issue
will just prove a statement from
the start of last month's article,
"you are in your home directory".
Whenever you see ~ this means
your home directory, so to prove
this, type (in a terminal):
pwd
I get this output:
$ pwd
/home/robert
Of course this will display your
home directory, rather than mine.
But what use is this to you? What
does it mean to be 'in your home

directory'? Any commands you
execute will be run in the current
directory. This won't mean much for
now, but it will make all the
difference later on. One command
that uses your current directory is
'ls', which will give you a list of files
in the directory you specify, or in the
current directory if you don't specify
one.
It's not always useful to be in your
home directory though, so let's move
away. To do this, we use the change
directory command, cd.
$ cd ~/Documents
If you now type 'pwd', you will see
you are now in your documents
directory. The '~/' was not needed for
that command although it can be a
handy shortcut to save time. In this
example, you were already in your
home directory, so 'cd Documents'
would have worked. If you were in
another directory though, say
'/home/robert/Pictures/2007/Decembe
r/Christmas' for example, it would
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take a long time to change to the
documents directory without
'~/'. However, now that you are
in your Documents directory,
how do you move back to your
Home directory? There are
several ways do to this.
$
$
$
$

cd
cd ..
cd ~/
cd /home/robert

These all do the same thing if
you are in your Documents
directory. 'cd' with no arguments
will always take you to your
home folder. 'cd ..' takes you to
your previous directory, so here
we moved from
'/home/robert/Documents' to the
previous directory,
'/home/robert'. The third uses
the ~ shortcut, and can be used
with or without the trailing '/'.
The final command uses the full
path, which will always take you
to the exact location, providing it
exists.
Now for some time saving!
Rather than typing out a long
directory like

'~/Pictures/2007/December/Christ
mas', you can just type the first
few letters!
$ cd ~/Pi<tab>
Replace <tab> with you
pressing your tab key, and notice
how it automatically changes to
Pictures? You can use this
technique with most directories to
save time.

You may have encountered
some problems performing these
simple commands. Don't worry
though, it is probably something
very simple. The first problem you
may have encountered probably
happened when you tried
changing to the Documents
directory.
-bash: cd: documents: No
such file or directory
Everything you enter at the
command line is case sensitive!
and
are
two completely different
directories in the eyes of the
terminal, so make sure you have
the correct capitalization! You

may also have had this error if you
don't have a Documents directory
because, for example, you have
deleted it. The other error you may
have encountered is when trying to
use tab complete. If your computer
gave a beep when you hit tab, it can
mean one of two things. The first is
that the directory doesn't exist. If the
directory doesn't exist, it won't be
able to tab complete it! The other
possiblity is that you have multiple
directories starting with Pi in your
home directory. If this is the case
then hit tab again, and you will get a
list of possible files and directories,
so you can type a few more letters
and hit tab again. If there are a lot of
possible matches, you will see
something like:
Display all 388 possibilities?
(y or n)
Unless you want to see them all,
type 'n', then hit enter and type a
few more letters to narrow down the
number of possible matches.
is a self confessed
geek, whose hobbies include:
programming/scripting, chatting on
IRC and not writing his articles on time.
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GetDeb extends the existing software
options for Ubuntu (and derived) Linux
distributions by providing major
updates and software not yet available
on the official Ubuntu repositories.

GetDeb packages are built using
Debian/Ubuntu building rules, this
reduces development effort and
assures the same level of quality.
However when new packages are
developed or major upgrades are
performed we do not follow a strict
quality assurance process, this is the
accepted cost required to achieve
shorter release times. Still with a
broader user base problems are
quickly identified as fixed. It should
also be noted that we do not provide
system core packages or major
libraries which could cause
dependency problems or other major
issues, in case you find a broken
package recovery should be easily
achieved by reinstalling the Ubuntu
official package.

www.getdeb.net

CREATE A SEPARATE
HOME PARTITION

HOW-TO

Written by Robin Catling

I

f you ran the default
installation of Ubuntu using the
"guided" partitioning option,
you probably have two partitions
on your hard drive: an Ubuntu
system partition and a swap
partition. This is fine until you run
regular backups, or upgrade to
Ubuntu 8.04, or need to recover
from a disaster. Then, having all
your data and programs on the
same partition suddenly seems
like a bad idea. Don't believe the
way that most file managers
present the contents of your
machine;
is still part of
your main filesystem. However,
keeping the system (Ubuntu) and
data (your own stuff) segregated
on separate disk partitions has
certain advantages. If I need to reinstall or re-format the system
partition, I can happily wipe it,
knowing nothing happens to the
folder. My backups become
simpler. Upgrades get easier. If
only there was a way to separate

.
There is, but this method comes
with no warranties and is liable to all
manner of user-goofs, so back up
everything first!

Unless you have unused disk
space, you will need to resize the
existing filesystem partition to make
room. Make sure you know how
much space you currently use for
/
and allow some room for
growth before you start this. You can
use an extra internal hard drive, but
don't try this on a USB drive, kids!
You will need one of the partition
editors capable of on-the-fly
move/resize operations leaving the
disk contents in place – the Parted,
Gparted, Visparted family do very
well. You need to run it from an
Ubuntu Live CD, Parted Magic or
System Rescue CD because your
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existing partition needs to be
unmounted to be resized and
thus your computer can't be
booted into your regular Ubuntu
installation.
If you screw up your
installation, you can use the live
CD to restore your old settings
and, in the worst situation, at
least recover your important
files. Launch Parted, select your
partition to resize, and then
select the Resize/Move button to
bring up the settings dialog box.

You can click-and-drag on the
partition graphic to set the
partition size or type a number in
the New Size box; it measures in
megabytes so you want a number
in thousands for gigabytes. Tab
out of the box to update the
Parted dialog. When you're happy,
click on the Resize/Move button
(bottom-right) to confirm your
settings. Nothing happens until
you click on the Apply button in
the main window.

Still in Parted, select the New
option and specify your partition for
the new /home. It uses the same
dialog box.
stick with one type of
filesystem. If your main partition is
ext3 – which is a good safe choice –
then create the new partition as
ext3. If you're on ext2 or Reiser, keep
the new partition the same. All the
Parted versions show the partitions
colour-coded by type on-screen.

Live CD session and we'll move
things around under the
temporary filesystem it creates.
Open a terminal; make a new
directory as a placeholder, then
mount the new partition under it:
sudo mkdir /mnt/newhome
sudo mount -t ext3
/dev/hda3 /mnt/newhome
Then do the same for your
main filesystem partition:
sudo mkdir /mnt/oldhome
sudo mount -t ext3
/dev/hda1 /mnt/oldhome
We need to use sudo for most
of these commands as they
need root permissions to run.

This may take a while. Each
section in the progress box is
expandable so you can see what's
happening at every stage.

Note the partition names, making
sure you know which is the old and
the new. In my example

Change directory into to the
oldhome mountpoint:

hda1 is oldhome

Since the “/home” directory
will have hard links, soft links,
files and nested directories, a
regular copy (cp) may not do the
job completely, so we'll use a

hda3 will be the newhome

Quit Parted. We're still using our
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cd /oldhome

different method. Take a deep
breath:

--null expect to receive filenames
containing spaces

sudo find . -depth -print0 |
sudo cpio --null --sparse -preserve-modification-time pvd /mnt/newhome/

--preserve-modification-time
keeps all the 'last modified
timestamps' intact through the copy
process.

What this does is to string two
commands together:
find is a native command that
follows the pattern 'find <whereto-look criteria> <what-to-do>.'
The period is the end of the
<where> clause, so by default
look at everything in the current
folder (remember we're in the
/oldhome/home folder structure).

p is for pass-through or 'by-pass the
archive step' and copy direct to
destination

Make sure everything has
moved cleanly before this step!
The folder name '/home' is a
significant reserved name in the
filesystem and we need to
rename the old /home so that
our regular Ubuntu session can't
mount it when we reboot - we
want it to use the new one:

v is verbose - list the files copied onscreen;

sudo mv /oldhome/home
/oldhome/home_backup

d specifies make-directories - create
the corresponding folders in the
destination folder.

The move command 'mv' is a
shorthand way to rename a file
or folder. The original home is
still there under a different
name. Nothing deleted yet.

Then:

-depth says search all the way to
the lowest level of the folder tree

Finally the /mnt/newhome/ is the
destination folder for the copied files.

-print0 is to include file names
with spaces

This copies everything while
preserving the last modification
timestamps.

The pipe '|' redirects the output
of the find to be the input for the
cpio command which always takes
its instructions from a prior
command.
So:
cpio is the copy command

Create a new placeholder in
the filesystem where the new
/home will be mounted:
sudo mkdir /oldhome/home

Having copied what we need, we
unmount it in order to re-mount it in
the right place later.
sudo umount /mnt/newhome
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Mount the new home under
this placeholder:
sudo mount /dev/hda3 /home
You should find all your

personal files looking exactly as
they did before. This is fine and
dandy for the Live CD session, but
now you have to make this
permanent for when you reboot
into your regular Ubuntu desktop.
Otherwise the new home won't be
mounted and you won't see your
Ubuntu desktop!

We have to modify the
/etc/fstab file. Fstab is the File
System Table, the quick lookup
the Ubuntu kernel uses like its
school register to see who's in
class, what their names are and
where they sit, except fstab lists
drives and partitions, not school
kids. The command:
sudo gedit /etc/fstab
opens the Gedit text editor so
you can add the line for your new
partition:
/dev/hda3 /home ext3
nodev,nosuid 0 2
This line essentially says
'mount /dev/sda3 under the
mountpoint /home,' with some

options. Amend this for your partition
name and filesystem.
If Gedit gives you trouble saving
this change, then my fall-back is a
character-mode text editor such as
Vi or Nano, which are on the Ubuntu
Live CD:

What if it doesn't work?
There are two real possibilities:
1. You messed up the find |

cpio copy command and not
everything ends up where it
should; the filesystem can't
mount what it can't find!

sudo nano /etc/fstab
Go to the bottom of the file, add
the line, and then save and quit -the key-strokes are control-o, enter,
control-x.

Close the Live CD session, then
reboot into your regular Ubuntu
session. Make sure everything is
working right, /
is mounted
where we specified, and all folders
are accessible.

2. You messed up your
/etc/fstab and didn't configure it
correctly - I have done this.

You've now got two copies of home
on your system, so if you're satisfied
the new one is good, clear out the
old:
sudo rm -r /old_home
This deletes the original home
folder and contents.
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in place of the nodev,nosuid
options, as in:

/dev/sdb2 /home ext2
defaults 0 2
Of course, item #3 means you
still can't identify the problem, in
which case recovery is required.
Boot up the live CD, go to a
terminal, and type:

sudo cp -R
/recovery/home_backup
/recovery/home
sudo cp
/recovery/etc/fstab_backup
/recovery/etc/fstab
And relax...

sudo mkdir /recovery
sudo mount -t ext3 /dev/hda1
/recovery

don't think this takes the place
of backups; regular backups are
still crucial.

There it is: /
on its own
partition. You can do the same for
any part of your filesystem if you
want to segregate the contents - just

occasionally earns
money as a project manager,
business analyst and technical
trainer. He also coaches fencing in
the New Forest, Hampshire,
England.

DOWNLOAD 8.04
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CREATE YOUR OWN
SERVER - Part 7

HOW-TO

Written by Daniel Lamb

W

e are now going to install
eGroupware onto your
server. This will give us a
groupware server which can
function like Exchange by
connecting an email client such
as Thunderbird to it via IMAP, and
connecting Sunbird to the
calendaring service via icalsrv.
First of all, we will need to copy
icalsrv into the eGroupware
installation folder. To do this, use
these commands:
wget
http://downloads.sourceforge.
net/egroupware/eGroupWare1.4.004.zip?modtime=120830122
9&big_mirror=1
unzip eGroupWare-1.4.004.zip
and now cp eGroupWare1.4.004/icalsrv
/usr/share/egroupware -r

The script will run through some preinstallation tests. Some of the items
will pass and some will have
warnings.
Click the 'continue to the Header
Admin' link at the bottom to
continue. You should now be on the
setup page. The 'Server Root' and
'Include Root' should be correct. You
can leave the admin user set to
'admin' and create a password. This
will be the account you use to login
to the header manager. Change
'Persistent Connections' to 'False'.
Scroll down to the database
information section, and enter the
information for the database you
created in step #1. In this example,
we'll use the following information:
- Stays the same.
- Stays the same.

This should be setup via mysql
server settings within webmin.
Choose a username and
password for the 'Configuration
User'. This is the account you'll
use to manage the
configuration. For this example,
we'll use the same username
and password as the header
manager.
Click the 'Write config' button
to create the header file. You
should get a screen saying that
your header file was created.
You should now be on the
eGroupware login page for the
control panel. Enter the admin
information into the
Setup/Config fields to login to
the setup control panel.
Click the 'Login' button to
continue. You should now be on
the setup screen for your
eGroupware. It will tell you that
the database is working but you

Now we can access the
installer. In this example, we'll
point to:
http://yourserver/egroupware/setup/.
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don't have any tables installed.
Click the 'Install' button to
create the core tables. The script
will create the core tables. If you
don't receive any error messages,
then it was successful.
Click the 'Re-check My
Installation' button to continue.
The setup page will refresh and
you'll see that all of the stages
have been complete.
Click on the 'Click here to setup
1 admin account and 3 demo
accounts' link to continue. Enter
the information you would like to
have for your admin account.
Check the 'Create demo accounts'
checkbox to create the demo
accounts.

Click the 'Save' button to save
these settings. You should now be
back at the eGroupware setup page.
Click the 'Back to user login' link at
the top left of the screen. If you get
an error message saying that the
lock function failed, create a support
ticket on the help page with the
name of your database, and lock
access will be granted to your
database. Refresh the page once lock
access has been granted. You should
now be at the login page. Enter the
information you created for your
admin account.

daniel.lamb@openyourwindows.com

Click the 'Login' button to login to
your eGroupware. You should now be
at the admin control panel for your
eGroupware management system.
eGroupware is now installed.
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owns and runs
and is based in
Perth, Scotland. He is also
involved in a number of open
source projects such as
,
and
.
He is also a committed Leeds
United fan.

HOW-TO

USING GIMP - Part 4

Written by Ronnie Tucker

T

his month, we will discuss
probably the most powerful
feature of GIMP: Layers. If
you can grasp the concept of
layers and work them to your
advantage, you can create
anything.

works. The background is on one
sheet, the character on another
sheet and any foreground details on
a third sheet. Stack them properly
and you will have the character with
the foreground on top of it. Same
with GIMP layers.

Below the list of layers, you
will see several icons. Think of
these as shortcuts to menu
options.

First, let's make sure we have
our layers window showing and
ready to use.

If you open an image in GIMP, and
display the Layers tab (or window),
you will see that your image is
displayed as a single layer with the
name 'Background'.

From left to right they are:
Create New Layer, Raise Layer,
Lower Layer, Duplicate Layer,
Anchor Layer and Delete Layer.
Those are pretty self explanatory.

If you don't
have the layers
tab available to
you, click File >
Dialogs >
Layers in the
main menu.

Using the selection tools from
last month's article, I'm going to
use the circle tool to select the
planet.

Here's how layers work: think of
each layer as a transparent sheet
of plastic. The idea is that you
draw all your different things on
separate sheets of plastic then
stack the plastic sheets in a
particular order to achieve your
result. Similar to how an animator
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And from the menu choose Edit
> Copy, then Edit > Paste

If I hide the original 'Background'
image, you can see that the
selected, copied and pasted planet is
now on its own, completely separate,
layer. Our first new layer!
You can copy from one image
and paste in to another image.

You can see that I now have a
new layer (named 'Floating
Selection'), but it needs to
become permanent, so click the
New Layer icon. It now has a
preview icon, and is automatically
renamed to 'Pasted Layer'. If you
want to rename a layer, just
double click on its name, and
enter a new name, followed by
the Enter key.

Don't worry about the two-tone,
chess-board pattern in the
background. It's just there to signify
complete transparency.
So now, with the planet selected,
I'll click the Duplicate Layer icon to
give me a second planet. To move
the layers, you use the Move tool,
select the layer you want to move,
then click and drag it into place. I'll
use some of our color altering
techniques to change the color of
one planet to make it easier for you
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to differentiate between the two
planets.
: If you have two images
open, you can drag and drop
layers between them!

Let's create
a new blank
layer. A new
layer is
created
above the
layer you are
currently on,
so I'm going
to select my (hidden)
Background layer and then click
the New Layer icon. Up pops the
New Layer window (above).

From top to bottom: We give
the layer a name (preferably
something descriptive! I'll call
mine 'Space'); Width and height
we won't bother with just now, as
we want the layer to be the full
size of the image; Layer Fill Type
we will leave as transparent. You
can choose white, or one of your
foreground or background colors
if you wish. Now, I'll make my
foreground color black and fill my
'Space' layer with black color.
So
now I
have
two
planets
out in
space. I
don't
need
the original image any more, so I
select that layer and click the
Delete Layer icon.
So what if I wanted the orange
planet in front of the blue planet?
I click the orange planet layer,
then click the Raise Layer icon.
Think of your layers as going
from bottom to top. So first, GIMP

lays down the 'Space' layer, on top of
that it puts the blue planet layer,
and, finally, on top of that the orange
planet layer.

When saving, you want to make
sure you save your image in the
GIMP format (XCF). The next time
you load the image you will still have
all the layers intact for manipulation.
Saving as JPG or PNG will flatten the
image and you will lose your layer
information, so always keep an XCF
version! To save,
you click File >
Save As from the
menu, and make
absolutely sure
the filename
ends in .xcf
(right).
Many effects can be applied to
layers to make them even more
powerful. Try moving the Opacity
slider (above the list of layers).
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Each layer can have one
'mode' applied to it. These are
listed in the drop-down menu
above the Opacity slider. Have a
play with these effects. You can
get some nice looking accidents
with these modes.

Above
is the basics of layers. No doubt,
we'll talk more about them in
future articles, but, for now,
have a play with copying and
pasting, raising and lowering
layers, and moving them to
create a pleasant composition.

is Editor of
magazine, a proud Kubuntu
user, and part-time artist whose
gallery of work can be seen at
www.RonnieTucker.co.uk.

HOW-TO

GRUB 101

Written by Damon Rios

F

or a variety of reasons, you
may need to repair your
master boot record (MBR).
Some of the common reasons
include:
a) Installing or reinstalling
Windows after you have installed
your Linux system (you will boot
right into Windows, without an
option to use Linux).
b) Using PartImage to clone
partitions to a new drive, as
explained in issue 12 (you will get
an error message, usually “No
operating system found”).
c) Installing another Linux distro,
and forgetting to configure the
bootloader to not overwrite the
MBR, something I typically do
(you will get the new bootloader,
which may not have your Ubuntu
system as an option).

CD which contains GRUB. In eight
steps, you will have your GRUB
menu back.

Type:
root (hdx,x) <output of
find command>
Then:

Boot the CD and open a terminal.

setup (hd0)
Followed by:

Type:

quit

grub

And finally:

Then:

reboot

find /boot/grub/stage1
The output of the find command is
important, as you will use it in Step
Five. Alternatively, you could mount
your partition, open
/boot/grub/menu.lst (from the hard
drive, not from the root of the live
environment), scroll down to the
uncommented line that says “root
(hdx,x)”, close, umount, and
continue. If you know which partition
you need, you can skip this step.

Not to worry, if you have a live
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What do steps 5 and 6 do?
Step 5 tells grub what partition
to boot from, and step 6 writes
that information to the master
boot record of the first hard
drive.

When you reboot into your
system, open a terminal and
enter:
sudo <your favorite editor>
/boot/grub/menu.lst

Below are two example entries
(for both Windows and Linux) that
are included in the menu.lst file.
# title
Windows
95/98/NT/2000
# root
(hd0,0)
# makeactive
# chainloader +1
#
# title
Linux
# root
(hd0,1)
# kernel /vmlinuz
root=/dev/hda2 ro
Copy and paste to the bottom
whichever you need, uncomment
all of the lines (remove #), change
the line “root (hd0,1)”, as needed,
and give it a try by booting into
your other partition(s).

is finishing a
Baccalaureate degree in Computer
Information Systems. His area of
specialization is networking,
including setting up and maintaining
servers, but he cannot stand
programming. He has been using
Linux (Ubuntu) for about a year, and
has contributed to FCM as both a
writer and a proofreader.

MY STORY

Written by Travis Moore

U

UBUNTU
SAVES THE DAY

buntu saves the day! As
clichéd as it sounds, Ubuntu
has, once again, won my
heart. I was at a friend's house, who
at the time was doing a travel
agency party/meeting. Her parents
are starting up a travel agency
website, which should be making
nearly $1,000 (~£500) a week. Her
mom, the main business woman,
was fruitlessly trying to get her
laptop to work with a VGA to HDMI
converter, then a HDMI to DVI.
Something was being lost in the
middle of that, because all we were
getting was the disappointment of a
black screen. I said, “I know how to
fix that.”

going to be displayed was a
Windows Executable file (not a
plain PowerPoint Presentation).
Thinking quickly, I installed Wine
and was able to get the
presentation working in a flash.
Then another issue: the
presenter wanted to use a
clicker, you know, one of those
wireless things that allow you to
navigate presentations and such
without having to use the mouse
and keyboard. Well, I thought my
luck was out, but I plugged it in
anyway. I couldn't believe it, it
worked! Then came a DVD,
which I had already taken care of
by installing libdvdcss.

I brought my laptop with a
graphics card suitable for HDMI to
DVI work. Of course, it was running
Hardy Heron, and I also had Envy
installed so that my Nvidia card
would play nicely. I connected the
HDMI cable, set it to TwinView, and it
worked! Then I ran into another
problem: the presentation that was

To make a long story short: the
presentation went well. Hardy
Heron, combined with Envy and
Wine made all presentation
problems vanish. I thank the
teams who work on these
projects.
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MY STORY

FROM MICKEY'S ABC
TO KUBUNTU

Written by Andrew Min

I

'll admit it. I was always a
computer geek. Ever since I
threw a tantrum over my
Mickey's ABCs game — Mom
wanted me to get off, but I didn't
— I've been involved with
computers. But I really started
getting into them when I
discovered Microsoft Publisher XP,
a program that tried to make
desktop publishing easy for users.
It never really took off, but I loved
it. One day, I found out how to
make a Web page. Then I decided
to go to the library to learn how to
create a better Web page. I
picked up
[1], and fell in love
with programming.
As I fell more in love with
computers, I found more
programming books. One day in
2003, I discovered an old O'Reilly
book about Linux (can't
remember the exact title).
Unbeknownst to me, it had been
written years before. I took a look

at the book. It
depicted a system
that looked like
DOS and included
some screenshots
of what must
have been KDE
1.0 (right). I
decided then that
I didn't want to
run Windows 3.1.
A few years
later, I had gotten into the instant
messaging craze. However, I didn't
want an official client. I wanted a
client that ran AIM, ICQ, MSN, Yahoo
and Skype, and included voice chat
for each. And I found
one:
(left).
That was when I
realized that it was
only for Linux. Then I
remembered hearing
about something
called VMWare being
able to run Linux
inside of Windows.
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So I searched
the
[2] for "KDE"
and found an
openSuSE
image. I
downloaded
it, ran it, and
fell in love
with KDE.
There was a problem,
however. I didn't want to replace
Windows yet. And the virtual
machine wasn't working, since I
had only 512MB of RAM. I
experimented with running
Puppy Linux from a USB drive,
but I gave up in disgust when I
saw the JWM window manager. I
also tried installing Slax, but
back then it was much harder to
install to a hard drive, and I gave
up as well.
Then in 2006, I found an
article in PCWorld about Ubuntu.

I read how
easy it was to
use, and
decided it
was for me.
But there was
one problem.
I hated the
brown theme.
Then, I found
out that there
was a KDE
sibling called
Kubuntu. I
immediately
ordered five CDs of Dapper Drake
(right) from ShipIt.
It took months for ShipIt's
package to arrive. When it did, I
was so nervous that I kept putting
it off. I finally summoned enough
courage to install it on a Saturday
in February 2007. Before I did,
however, I learned that Edgy Eft
had been released. I burned a CD
and installed Kubuntu 6.06. It
wiped my hard drive. Happily, I'd
had the foresight to back up, so I
reinstalled Windows XP and
Kubuntu. In the process, I found
out that Windows XP gets a lot
faster if you reinstall it. But soon, I

wasn't worried
about
Windows.
Once Kubuntu
was installed, I
fell in love with
it. The
package
manager (even
SuSE's YaST
isn't as good
as aptitude),
the stability
(no crashes
every five
minutes), and the speed (contrary to
my own belief, Kubuntu actually was
faster than XP) combined
to make it an operating
system worthy of
replacing Windows. Since
then, I've tinkered around
with different operating
systems, but they all had
problems -- MEPIS used
outdated software, SuSE
used an annoying YaST
package manager, and
Freespire was just allround, bad. Kubuntu ain't
perfect, but it's the best
I've seen so far.
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Oh, and ironically, I don't even
use Kopete any more.
[1]
http://www.redwall.org/dave/davesbook
.html
[2] http://www.vmware.com/appliances/

is a Christian, an
American, a student, and a huge
Kubuntu fanboy. Find out more
about him at
http://www.andrewmin.com

REVIEW

HP PHOTOSMART
C3180 PRINTER

Written by Ronnie Tucker

H

aving done my research for
a nice, cheap, Linuxcompatible printer, on
Google and Ubuntu Forums, I
decided upon the HP Photosmart
C3180.
It's an 'all-in-one' printer,
meaning it can print (like a normal
printer), scan (like a flatbed
scanner) and copy (like an office
photocopier). I should also
mention that the copy function
can be used even while the PC is
off. Unlike the more expensive
models, this one does not do fax.

After powering on the printer and
plugging in the USB cable to my PC,
Kubuntu Hardy automatically
detected the printer, told me it was a
C3100 series from HP, and then
displayed a printer icon (below) in
my tray and also a bubble telling me
it was configured and ready to use! It
really was that easy.
Clicking the printer icon
gives access to the print
jobs.
After installing the black and color
cartridges (which come with it), the
printer automatically spat out a test
page. This showed that the various
colors were working effectively, as
was the rest of the printer.
Next, I opened a document in
OpenOffice. I clicked print (above
right) and it worked! Easy as pie.
Then I decided to copy one of the
pages I'd just printed. I put the paper
on the scan area and pressed the
copy button. It worked! By now, I was
getting suspicious -- this was just too
good to be true.
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Getting the printer to scan
caused me a few moments of
head-scratching, but this was
because I didn't have SANE
installed. SANE is a scan
application that effectively sits
between other applications and
the scanner. I installed and
loaded up SANE, did a preview
scan, selected an area, clicked
scan and that was it! I loaded up
GIMP and, after installing SANE,
it now had the necessary option
to acquire from the scanner.

Looking at the printer itself, it
has two main lights on top which
alert you when the paper is out or
the ink is low. It also has a
number of buttons on it:

The copy buttons give you quick
access to altering the paper type, the
copy quality, the copy size, and the
number of copies to produce. Below
those are two more buttons for
copying in color or in black. The last
button is for scanning.
On the front of the printer are
several card slots:

method is to fill in the page to
select the thumbnails you want
printed as photos, and then put
the page into the scanner to
enable it to detect (using OCR I
assume) what you filled in on
the page, and to print your
request. How can this be done in
Linux? I have no idea. The card
slots still allow you access to
your photos via GIMP or
whatever photo album software
you use.
I'm not sure if it was always
there, or added during detection,
but I spotted an HP Device
Manager (below) application in
my Kubuntu menu.

These work just like a card reader,
so my USB card reader is now
redundant. Since there is no
screen (to view your photos)
on the C3180, you press the
thumbnails button on the
front of the printer (it flashes
when you insert a card), and
out will come a page (or
pages) with thumbnails of
your photos. Now, this is
where we seem to find a
Windows/Mac only option. The
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This gives access to the main
print, copy, and scan functions
(with a handy function to let you
queue up files to print), but also
to status and supply reports (ink
levels), tools (test pages, clean
and align the cartridges), and
print settings (for print quality).
I really can't fault the printer at
all. It installed so simply that I
was suspicious of it. I tried all the
basic features (printing, scanning,
and copying) and they worked
easily and flawlessly.

Device Type - Copier / printer / scanner
Printing Technology - Ink-jet - colour photo

Ink Cartridge Configuration - 1 black
cartridge, 1 colour cartridge (cyan,
magenta, yellow)

Monthly Duty Cycle (max) - 1000
impressions

Colour - 4 or 6-ink

Office Machine Features - Print from
memory card

Ink Type - HP Vivera Inks
Scan Element - CIS

Width - 43.4 cm

Optical Resolution 1200 x 2400 dpi

Depth - 29 cm

Interpolated Resolution - 19200 x
19200 dpi

Height - 16.2 cm

Grey Scale Depth - 8 bit

Weight - 5.1 kg
Localisation - Western Europe
Memory - 32 MB
Max Supported Memory

I bought my HP C3180 from
eBuyer.com for £35 (~$70). New
ink cartridges are approximately
£15 each (~$30).

Max Printing Speed - Up to 22 ppm
(mono) / up to 20 ppm (colour)

32 MB

Supported Flash Memory - Memory Stick,
CompactFlash, SD Memory Card,
MultiMediaCard, xD-Picture Card, Memory
Stick Duo
Max Copying Speed - Up to 22 ppm
(mono) / up to 20 ppm (colour)
Max Copying Resolution - Up to 600 x 600
dpi (mono) / up to 4800 x 1200 dpi
(colour)
Max Document Enlargement - 400%
Max Document Reduction - 50%
Maximum Copies - 50
Inkjet Technology - HP Thermal Inkjet
Max Printing Resolution - Up to 1200 x
1200 dpi (mono) / up to 4800 x 1200 dpi
(colour)
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Colour Depth - 48 bit
Max Original Size - 215 x 297 mm
Original Type - Sheets
Min Copy Size - 77 x 127 mm
Max Copy Size - 215 x 610 mm
Min Copy Weight - 75 g/m2
Max Copy Weight - 236 g/m2
Supported Media Type Transparencies, envelopes, plain
paper, cards, labels, iron-on
transfers, photo paper
Standard Capacity - 100 sheets
Output Trays Capacity - 50 sheets
Speed Details - up to 22 ppm ( A4 ) B/W draft ¦ up to 20 ppm ( A4 ) colour text and graphics draft

MOTU INTERVIEW

MATHIAS GUG

Taken from

Behind MOTU is a site featuring interviews with those known as 'Masters of the Universe' (MOTU). They are the volunteer army of
package maintainers who look after the
and
software repositories.

kernel. I’ve never left since then.

I installed Ubuntu one and half years
ago, it was Xubuntu 6.06 IIRC.
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Montreal, Canada
mathiaz

The first time I saw linux was in
1997, Redhat IIRC. The first time I
downloaded it was in September
1999, Debian. But I gave up after
a couple of weeks. I came back
during summer of 2000 with
Mandrake Linux and the 2.4

they’re all outlined. And last, but
not least, the irc channels
(#ubuntu-motu and #ubuntudevel), are great resources. I
always find someone to help me
there.

I was hired by Canonical as the first
member of the Ubuntu Server Team
last May. I started packaging
AppArmor and other server-related
software — which led me to become
a member of the MOTU team.

Being part of a great team trying
to deliver the best of the free
software world. There are lots of
interesting challenges when it
comes to packaging - you get to
learn how things work under the
hood.

I’m using the packaging guide from
help.ubuntu.com, the Debian New
Maintainer Guide, and the Debian
Policy. For processes, I just keep
referring to wiki.ubuntu.com where

Start simple, start small. Pick
one bug or one package and try
to fix it. Ask for sponsorship, and
you’ll learn a lot of things in no
time.
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One of the projects I’ll try to work
on is a better packaging
framework for web applications.
So that such application can be
added to the universe easily and
in a consistent manner.

Most of them are in the server area I’ll keep on working on security with
AppArmor. Server hardware testing is
another area I’m interested in.

Plutarch quoting Socrates

Among others things, I go swing
dancing several nights a week,
both in Montreal and in other
places in North America. I’m also
a big traveller: I’ve just returned
from an eight month
backpacking experience in Asia
covering Mongolia, Tibet, Nepal
and India.

ubuntu
forums
.org
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UBUNTU WOMEN

Written by Emma Jane Hogbin

community is a Code of Conduct
(CoC) that governs our behavior [1].
It is simple and elegant. There are
six main points in the code: Be
considerate. Be respectful. Be
collaborative. When you disagree,
consult others. When you are unsure,
ask for help. Step down considerately.
Recently, the Ubuntu Women
discussion list had an interesting
exchange about the Code of Conduct
entitled “How has the Code of
Conduct Helped You?” [2] [3]. The
responses showed a disconnect
between our eagerness to sign the
code, and our apathy towards
upholding it.

F

or me, the Ubuntu logo
represents freedom and
community. The word itself
means “Humanity towards
others.” Within the Ubuntu

The Ubuntu community is full of
life, and is a delight to participate in.
Sometimes, though, I am not the
epitome of the behavior defined in
the CoC — whether it’s cracking
jokes with friends in an IRC channel
or engaging in passion-fuelled
debate, I sometimes forget to rein
myself in. When I slip, I enable
others to slip too. This can start a

27

domino effect of bad behavior
that extends much further than
the original interaction. By
remembering to govern myself
according to the CoC, I enable
others to participate in the same
way. I encourage everyone to
join me in reading the CoC at the
beginning of every month —
let’s see how far we can spread
the good behavior too!
[1]
http://www.ubuntu.com/community/con
duct
[2]
https://lists.ubuntu.com/archives/ubunt
u-women/2008-June/001594.html
[3]
https://lists.ubuntu.com/archives/ubunt
u-women/2008-July/001598.html

builds and
supports on-line communities
using open source software. She
lives in rural Canada and
chronicles her adventures at
www.emmajane.net.

UBUNTU YOUTH

Written by Uwe Hauck

The future of open source is in the young people of today; that's
why this corner of the magazine is for young people or simply
those who are young at heart.

I

First contact was made!

am a long-term Linux
aficionado. My first contact was
in the early 90s with the early
versions, but that was more of an
academic interest as I was
studying Computational
Linguistics and Artificial
Intelligence by that time, and, in
my department, the OS of choice
was Unix.
I moved on, got married, had
children, and about six years ago
my interest in Linux grew again.
My first contact was SuSE, but,
with Feisty Fawn, I made the
switch to Ubuntu.
My wife was not so much into
computers at that time; she was
always fearful of viruses and
catching Trojans while surfing the
Web. So more as a joke, I said
"Why don’t you try Ubuntu; it's
safe, easy to use, and you'll love
it". To my big surprise, she
agreed, and I created a partition
with Ubuntu Linux on our family

desktop PC. Sure enough, she liked
it, and became a computer addict,
and the perfect match for a nerd like
me.
We are running four machines at
the moment — all equipped
exclusively with Ubuntu, with the
exception of the family PC, which still
has one partition for Windows XP for
those 'special' games the kids like so
much. But there is hope. Our oldest
son (aged eight) watched my wife
the other day playing her favorite
game, Widelands, and asked: "can I
play it too?"
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I use a Sony Vaio VGN-FZ31J
DualCore notebook, perfectly
supporting nearly everything
despite the NVIDIA graphics
card, which works well but still
waits for the dimming feature. In
addition, I couldn’t resist buying
an ASUS EEE PC 700 -- my
sidekick in the office, and my
surfboard on the couch. And it is
great! Having installed Ubuntu
on the EEE, I can do everything
on the road. It even supports
Compiz Fusion out of the box! It
has become my media centre,
portable video player,
information centre (on the road),
and much more. Even watching
TV is possible with the Zattoo
player or a DVB-T stick.
At home, I add a USB
keyboard, mouse and a 21 inch
widescreen. To my big surprise,
my little EEE PC even supports
1600x1050 resolutions! As soon

as one of my kids needs a
computer for their school work at
home, they will get an EEE — or
something similar — and for sure
it will run Linux. With three kids,
my reasoning is: for the price of
one full-blown notebook we can
afford three EEE PCs with
additional keyboard, mouse and
monitor. And you can always
easily remove the PC from the
kids room, should they spend too
much time on the computer.
At the moment, my kids use an
Acer Desktop PC with an AMD
Dual Core processor and a tripleboot setup with Windows XP,
OpenSUSE 10.1 and Ubuntu 8.04.
My wife uses my 'old' Notebook, a
Samsung R55 DualCore, with you guessed it - Ubuntu, and does
a lot of correspondence, planning
our social involvements, surfing
the Web, and, of course, playing
Widelands. We use a wireless
print server, so anyone in the
house can print on the family
printer, a Canon MP750, via WLan.

access our music collection and the
family documents from a single
source. The EEE PC and my notebook
run F-Spot, so we have our collection
of family photos with us all the time,
and they become great high-tech
picture frames in screensaver mode,
flipping through our family album. I
have Firefox with Foxmarks, so
whatever computer I use, I have all
my bookmarks with me.

And I am running GCalDaemon
for Evolution on my notebook,
with multisync and the Bluetooth
plug-in for Sony Ericsson phones.
That way I can keep the calendar
and addresses on my mobile
phone automatically in sync with
the family calendar on Google
whenever the phone comes into
the Bluetooth range of my
notebook.

Our family calendar runs on
Google Calendar, and with
Thunderbird, Lightning and Provider
running on each computer, we all
have our family dates in sync,
everywhere. I can even check if my
extra office hours fit with the family
schedule, and I can update my
business dates without having any
private dates on my office computer.

And of course, the whole
family is equipped with Ubuntu
merchandise. Why? So no one
can miss the fact that we are an
Ubuntu family. And, through
several talks, I have already
convinced about five of our
friends and my colleagues to
give Ubuntu a try and, yes, three
have made the switch, one of
them completely.
is a software developer
and Ubuntero, participating in
translations, bug fixing, and trying to
convince as many people as possible
to try Ubuntu. He lives in Schwäbisch
Hall, Germany, and is married, with
three kids.

I have added an USB drive to
our WLan router that acts as a
network drive so everyone can
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LETTERS

I

n issue 13 Alessandro
mentioned that his friend's
laptop worked better with
Ubuntu. I'm not going for any
case badges here, but Ubuntu
works better. At this moment I run
a Ubuntu 8.04 server, Ubuntu
7.10 on my desktop and Ubuntu
8.04 on my laptop. To make a
long story short, on the desktop,
the HP-5L laser printer prints
better in Ubuntu, the tv-tuner
works seamlessly (in Windows its
proprietary drivers have a sound
problem), and that's not all
because the sound card drivers
from Ubuntu send a better signal
to the speakers. And it is all for
free, free as in free speech of
course, but in this case it's free as
in free beer.
I've been dual booting Windows
and Linux since 2004 but Ubuntu
got me Windows free about 6
months ago. Last month I even
got a friend of mine to switch to
Ubuntu 7.10 on her old PC. It's

Every month we like to publish some of the emails we receive. If you would like to
submit a letter for publication, compliment or complaint, please email it to:
letters@fullcirclemagazine.org. PLEASE NOTE: some letters may be edited for space reasons.

LETTER OF THE MONTH

Writer of Letter of the Month wins
two metal Ubuntu case badges!

I

started using Ubuntu in June of
2006 (Dapper Drake) because I
hated Windows' proprietary
stuff. I got tired of not being able
to fix bugs myself and not being
able to get updates until Tuesday
of the following week. I finally said
"forget this" and went on a search.
I found SUSE Linux first, but due to
its non-user-friendly approach I
went searching again. I finally
came across Ubuntu and, of
course, when I first began using
Ubuntu I had a few problems - one
or two compared to Windows

thousands. Then I found
Ubuntu Forums and the
beginner team. Those guys
helped me so much! Since
first using Ubuntu - until today
- I have great appreciation for
the Free and Open Source
community and developers.
Ubuntu is awesome, and I do
not believe I will change
because of the amazing
support from the community
and Canonical.

just a small deed for what Ubuntu
gave me instead.

experience proved, without this
piece of software working, the
computer is useless:

I

I got the Windows Paragon
Partition Manager last week to
get back space required for XP

think a useful article for a future
edition should cover the GRUB
bootloader as my recent
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from one of the two Ubuntu
partitions - on the first laptop this
worked fine, Paragon brought the
message to reboot to complete
which it did in the blue checkdisk
screen in XP.

it took me so long to sort out the
players with previous versions up to
7.10 which worked.
I downloaded GParted in Ubuntu,
but couldn't figure out the program
to delete and resize partitions, with
no help menu, and it didn't seem
very user friendly like Paragon's.

However in the second laptop,
Paragon decided to complete
within XP and on rebooting I just
Each week there's more and more
got a message about GRUB
space required for security fixes and
loading but with
upgrades in the
error 17 (whatever
latest 8.04 version,
I'll be back with
that means). I only
seems like it's
Ubuntu when these
got things up and
averaging 80Mb a
running again by
have been resolved...
week, so eventually I
booting the Ubuntu
thought I'll be running out of disk
CD, manually deleting the Ubuntu
space, especially as previous
partitions in the setup and letting
versions are kept in another partition
it complete to reload the boot
automatically - so I'm sticking with
menu. Now everything works fine
XP instead for less updates, a higher
again and I achieved the extra
resolution display, and a far less
space I wanted for XP.
complicated way of getting programs
A few gripes I've got about
without worrying about some
Ubuntu are: the boot menu gets
meaningless file names that are
more and more versions added going to be uninstalled if I install
how do I delete those that don't
another program in Ubuntu.
apply and don't exist anymore or
Uninstalling in Ubuntu risks disabling
never used?
the whole computer without any
warning notices so I've given up on
With the latest upgrade to 8.04,
this after one disaster.
the radio players don't work any
more so I've given up with this as
I'll be back with Ubuntu when
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these have been resolved, but in
the meantime I'm for an easier
computer experience (life) with
XP, where I don't have to think
that much or worry whether the
laptop will reboot again after the
latest changes.

Ed:

J

ust a suggestion for the
magazine: how about an
article explaining clearly how
to deal with tar.gz, BZ2 etc. I
know it is in the docs, but it is
quite confusing for a beginner.
I think it would be nice and
very useful for the community.

Ed:

.

Q&A

Written by Tommy Alsemgeest

If you have Ubuntu-related questions, email them to:
questions@fullcirclemagazine.org, and Tommy will answer them in a future issue.

Q

Q

A

A

Yes, you can easily transfer
them - by copying the files
across to your XP partition
or drive from within Linux. You can
access your Linux partition from
within XP by installing the
driver in Windows.

Q
You can fix it by running
from the live cd, or by
running it with the -f flag, like

this:

sudo e2fsck -f /dev/sda1

A

Set the SH file permission
first to executable:

chmod u+x
/path/some_linux_installatio
n.sh
Then run it with:

Q

sh
/path/some_linux_installatio
n.sh

A

./some_linux_installation.sh

or:

Firefox is probably missing
a plugin. Take a look here:
http://ubuntuforums.org/sho
wthread.php?t=766683.

If I download files to
Linux, can I transfer
them to Windows XP?
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MY DESKTOP

Your chance to show the world your desktop or PC. Email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your
desktop, your PC's specs and any other interesting tidbits about your setup.

I am using a 10 year old Daewoo, Pentium III, 1.0GHz, 384 MB
RAM, 20GB HD. It has so many hardware problems that it takes
several tries to properly start Ubuntu. But once it starts, the
machine becomes alive! I mean, I can do so many things with it I
don't want to let it go. I enjoy Ubuntu, and I love that I have the
option of changing its appearance.

I've used Ubuntu since Dapper, and now use Gutsy with Compiz
Fusion and Emerald - on a Core 2 Duo 2x2.2 GHZ with 1GB of
RAM and an nVidia GeForce 8600GT. It runs like a charm. I plan
to upgrade to Hardy as soon as the Final hits the Servers.
I used the wonderful looking
icon theme from gnomelook.org. The Emerald theme was mixed using System-Colors,
the dockbar is the Avant Window Navigator. For the Wallpaper, I
went to theinspirationgallery.com?, and found a pattern, and
edited it to a Victorian-style dark background image.

My theme is a custom collection made up of the following: Black
Plastic (for controls), Vista Mix Dark (for window borders), and
Human Default (for icons). I found everything, including the
background, at gnome-look.org
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MY DESKTOP

Presently, I have Ubuntu 7.10 installed on an Acer Aspire
notebook: 1.60GHz, dual-core, 1GB RAM, 80GB Hard disk, WiFi,
and Bluetooth.

Relatively little has been tweaked to achieve this look of my
Ubuntu 8.04 desktop. Icons are the 'Tango-style' theme found on
gnome-look.org. The wallpaper is from Interfacelift.com. The
window borders are a modification of 'Humanoid OS X Dark', also
on gnome-look.org. I modified it to inherit the color of the
buttons from the GTK theme colors, and to show a more neutral
border on the inactive window - to make the active window more
easily distinguished from the rest.

I have a highly customized and personalized installation. The
appearance aspects are: Compiz Fusion with the Emerald
window border decoration. Icons are OSX, and the control
theme is Aero-clone. The default panel is neatly tucked away on
the top left. Cairo-clock is at the bottom left. AMSN messenger
is there too - with the aMSN live skin. And PCMan File Manager
for tree structures and fast access. At the bottom centre of the
screen I use AWN curve to move between running applications.
Applications can be launched from the menu accessible with
Super L+Alt key.

The GTK theme is the standard theme Clearlooks, with colors
chosen to match the icons and wallpaper. Drop shadows are due
to the Desktop Effects, as is the transparency of the screenlets.
All running on my trusty Lenovo 3000 n100.
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TOP5 SLIM WEB BROWSERS
Written by Andrew Min

Your monthly list of Linux games or applications
from the depths of the Internet. If you have an idea
for a list, please email: misc@fullcirclemagazine.org

Homepage: http://www.gnome.org/projects/epiphany/

Homepage: http://www.dillo.org/

(also
known as "GNOME
Web browser") is
one of the best
Web browsers for
Gnome users.
Based on the now
defunct but
formerly popular
,
has full Gnome
support, has tons of extensions, uses the standardsbased Gecko browser engine, and is, overall, a fully
functional Web browser. While you probably wouldn't
use this baby in KDE, Epiphany is a wonderful tool if
you're a Gnome user who is sick of Firefox's bloat but
still want feature-rich browsing.

If you like simplicity,
is perfect for
you. It's one of the
ugliest applications
I've ever seen, but
it takes up the
smallest amount of
window real estate
I've ever seen. It's
also lightning fast,
but that's mainly
because it doesn't support Java, JavaScript, or CSS.
Heck, it can't even display some characters! Think of
it as a graphical Lynx, except that it can display
images. That's not to say that
is useless,
however. It's perfect for just getting information when
Firefox is slowed to a crawl, and you want the info
now. Yes, I'm American.

When installing
, do not use the
package unless you want a Boulder Dash clone.
Instead, you should install the
package in the Universe repository.

To install
repository.
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, use the

package in the Universe

Homepage:
http://www.arora-browser.org/
This simple, cross-platform browser is
one of my favorites on the list, mostly
for its speed. It's blazing fast - even
faster than Firefox 3 in my informal
tests. It also looks great in both KDE and
Gnome. And, for a project with less than
10,000 lines of code, it's got quite a few
features, including tabs, bookmarks, and
history. You do need to note that it is a
tad unstable (it's not even in alpha yet).
Since it's not stable yet,
isn't in
the Ubuntu repositories. To install it, add
the Backport repositories (go to
Software Sources and check
"Unsupported updates" in the Updates
tab), and then install the latest .deb
from the
homepage.

Homepage: http://midori.sourceforge.net/
For those who liked
's fast, lightweight,
WebKit-powered engine, but didn't like Qt,
is worth a go. Since it's WebKit, it's
blazing fast. And it also has quite a few
features - tabs, lots of interface
customizability, proxies, and a very handy
form fill. However, it still manages to stay
light and unbloated - a lesson many other
browsers should take note of. Note that, like
, it is definitely heavy alpha, so only the
brave should install it.
To install
, grab the
package
from the universe repository. You can also
grab the
package if you're
having some problems debugging it.
has been a Linux addict
since he first installed openSuSE in
VMWare. Learn more about him at
http://www.andrewmin.com/
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Homepage:
http://kazehakase.sourceforge.jp/
WebKit is blazing fast, but often
renders pages incorrectly. Gecko
(Firefox's engine) renders everything
except ActiveX, but is fairly slow. That's
where
comes in. Unlike
most browsers (which only have one
engine),
has support for
both Gecko and WebKit, with more
engines like GkHTML, Dillo, and w3m
to come. It also includes a very
powerful GTK interface, complete with
different levels of complexity
(Beginner, Medium, and Expert),
bookmarks, and much more.
To install

, use the
package in the universe
repository. In Intrepid, you'll also have
to choose between
and
,
since the Hardy version supports only
Gecko.

HOW TO CONTRIBUTE
We are always looking for new articles to include in Full Circle. For article guidelines,
ideas, and for issue translation, please see our wiki:
http://wiki.ubuntu.com/UbuntuMagazine
Please email your articles to: articles@fullcirclemagazine.org

If you would like to submit news, email it to:
news@fullcirclemagazine.org
Send your comments or Linux experiences to:
letters@fullcirclemagazine.org
Hardware/software reviews should be sent to:
reviews@fullcirclemagazine.org
Questions for Q&A should go to:
questions@fullcirclemagazine.org
MyDesktop screens should be emailed to:
misc@fullcirclemagazine.org
If you have questions, you can visit our forum:
www.fullcirclemagazine.org
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- Robert Clipsham
mrmonday@fullcirclemagazine.org
Samuel Barratt
Daniel Cohen
Andrew Min

Robert Clipsham
Philipp Höhn
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HAVE YOUR SAY
If you want to have your say on how
Full Circle Magazine develops, please
attend our monthly IRC meeting.

Jim Barklow

You can find our next Agenda at:

Mike Kennedy

http://url.fullcirclemagazine.org/f2ba08

David Sutton

We want input from you, the reader, to
help us make decisions that affect the
magazine.

David Waldrop

Next general meeting (all welcome):
at
.

Matt Janeski

Meetings take place in the IRC channel
, which is on the
irc.freenode.net server. Or you can use
our webIRC page which is at
http://irc.fullcirclemagazine.org and it
will allow you to interact with our IRC
channel from within your web browser.

Friday 29th August.
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Gord Campbell
David Haas

Andrew Min

And our thanks go out to
, the
and the many translation
teams around the world.

